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Technical Support
Symantec Technical Support maintains support centers globally. Technical Support’s
primary role is to respond to specific queries about product features and functionality.
The Technical Support group also creates content for our online Knowledge Base.
The Technical Support group works collaboratively with the other functional areas
within Symantec to answer your questions in a timely fashion. For example, the
Technical Support group works with Product Engineering and Symantec Security
Response to provide alerting services and virus definition updates.

Symantec’s support offerings include the following:

■ A range of support options that give you the flexibility to select the right amount
of service for any size organization

■ Telephone and/or Web-based support that provides rapid response and
up-to-the-minute information

■ Upgrade assurance that delivers software upgrades

■ Global support purchased on a regional business hours or 24 hours a day, 7
days a week basis

■ Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our Web site at
the following URL:

www.symantec.com/business/support/

All support services will be delivered in accordance with your support agreement
and the then-current enterprise technical support policy.

Contacting Technical Support
Customers with a current support agreement may access Technical Support
information at the following URL:

www.symantec.com/business/support/

Before contacting Technical Support, make sure you have satisfied the system
requirements that are listed in your product documentation. Also, you should be at
the computer on which the problem occurred, in case it is necessary to replicate
the problem.

When you contact Technical Support, please have the following information
available:

■ Product release level

■ Hardware information
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■ Available memory, disk space, and NIC information

■ Operating system

■ Version and patch level

■ Network topology

■ Router, gateway, and IP address information

■ Problem description:

■ Error messages and log files

■ Troubleshooting that was performed before contacting Symantec

■ Recent software configuration changes and network changes

Licensing and registration
If your Symantec product requires registration or a license key, access our technical
support Web page at the following URL:

www.symantec.com/business/support/

Customer service
Customer service information is available at the following URL:

www.symantec.com/business/support/

Customer Service is available to assist with non-technical questions, such as the
following types of issues:

■ Questions regarding product licensing or serialization

■ Product registration updates, such as address or name changes

■ General product information (features, language availability, local dealers)

■ Latest information about product updates and upgrades

■ Information about upgrade assurance and support contracts

■ Information about the Symantec Buying Programs

■ Advice about Symantec's technical support options

■ Nontechnical presales questions

■ Issues that are related to CD-ROMs, DVDs, or manuals

www.symantec.com/business/support/
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Support agreement resources
If you want to contact Symantec regarding an existing support agreement, please
contact the support agreement administration team for your region as follows:

customercare_apac@symantec.comAsia-Pacific and Japan

semea@symantec.comEurope, Middle-East, and Africa

supportsolutions@symantec.comNorth America and Latin America
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Introduction and notes

This chapter includes the following topics:

■ About the Symantec NetBackup plug-in for VMware vCenter

■ Notes and recommendations on the NetBackup plug-in

■ How to access the features of the Symantec NetBackup plug-in

About the Symantec NetBackup plug-in for VMware
vCenter

With the NetBackup plug-in for vCenter, you can use vSphere Client to monitor
virtual machine backups and recover a virtual machine from a backup.

You can use the plug-in to do the following:

■ View the backup status of virtual machines at various vSphere levels. For
example: Datacenter, resource pool, ESXi host.

■ View messages that are related to backups, such as snapshot deletion failure.

■ Sort and filter the backup information and export the information for analysis.

■ Recover virtual machines. (The recovery feature is optional and is not required
for monitoring virtual machine backups.)

The backup information appears on the Symantec NetBackup tab in the vSphere
Client interface.

You can start a virtual machine recovery from any of several points in the vSphere
Client interface.

See “How to access the NetBackup Recovery Wizard” on page 45.

Figure 1-1 shows a VMware environment with NetBackup servers and the NetBackup
plug-in.
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Figure 1-1 VMware environment with NetBackup plug-in
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Support for ESX and ESXi
NetBackup for VMware supports both ESX and ESXi servers. In this document,
any reference to ESXi also refers to ESX.

Note that VMware no longer supports ESX in the latest versions of vSphere.

For the VMware versions that the NetBackup plug-in supports:

See “Requirements for the NetBackup plug-in for vCenter” on page 13.

Notes and recommendations on the NetBackup
plug-in

Note the following about the NetBackup plug-in for vCenter:

■ The best screen resolution for the plug-in is 1280 x 1024 or greater.

■ The plug-in does not support auto-refresh. To refresh the display, click the
refresh button at the top.

■ In vCenter, the default retention period for vCenter events is 180 days. This
value is the recommended setting.

■ The plug-in does not support use of the https://<IP_address>:5480/ URL for
setting properties.
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■ The plug-in does not support multiple vCenter servers. The plug-in is intended
for monitoring and restoring virtual machines within one vCenter server. The
plug-in Recovery Wizard can browse and restore images of virtual machines
from only one vCenter.
To use the plug-in with another vCenter, you must either unregister the current
vCenter or install another plug-in.
See “Manually unregistering the NetBackup plug-in for vCenter” on page 21.

■ If Enhanced Security Configuration is enabled in Internet Explorer on the
vSphere Client host, you may need to add the plug-in as a Trusted site. This
step is only required when you first open the Symantec NetBackup tab on the
vSphere Client host.

■ If the plug-in virtual appliance is configured on an NFS datastore, the NFS server
determines the type of disk provisioning that you can use. Note that thick
provisioning may not be available.
The following VMware article contains more information:
VMware vSphere Online Library: About Virtual Disk Formats

■ Depending on your firewall configuration, you may need to modify your firewall
rules to allow the vSphere Client host to access the plug-in host. vSphere Client
must have access to the port to which the plug-in host is configured.
Note: The default port for the plug-in host is 9445.

■ If an ESXi server is removed from vCenter and is later re-added, the events for
the VMs managed by that ESXi are lost. The plug-in shows the status of such
VMs as "No Backup Information." The status changes as new backup events
occur for each VM.

■ See “Notes on restoring virtual machines with the NetBackup RecoveryWizard”
on page 45.

■ When the plug-in installation completes, restart the vCenter service VMware

VirtualCenter Server if you use vCenter 4.0.

■ The plug-in monitors backups that a NetBackup VMware policy made. The
plug-in does not monitor backups from other policy types.

Note the following exceptions:

■ The plug-in does not monitor backups from a VMware policy that had Use
Replication Director enabled and Application Consistent Snapshot
disabled (under Options).

■ The plug-in does not monitor all the copies that a storage lifecycle policy
(SLP) makes: It monitors the first image only.
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How to access the features of the Symantec
NetBackup plug-in

Table 1-1 describes the location of the NetBackup plug-in features in vSphere
Client.

Table 1-1 Basic functions in the Symantec NetBackup plug-in

How to access in vSphere ClientFeature

Use the Symantec NetBackup tab.

See “Symantec NetBackup tab in vSphere Client” on page 25.

Monitor the status
of virtual machine
backups

You can access the Recovery Wizard in several ways.

See “How to access the NetBackup Recovery Wizard” on page 45.

Note: The Recovery Wizard is optional. It is not required for monitoring
virtual machine backups.

Restore a virtual
machine
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Installing the NetBackup
Plug-in for vCenter

This chapter includes the following topics:

■ Requirements for the NetBackup plug-in for vCenter

■ Configuration overview for the NetBackup plug-in for vCenter

■ Consistent naming for the vCenter server

■ Upgrading the NetBackup plug-in for vCenter

■ Installing the NetBackup plug-in for vCenter

■ Disabling or uninstalling the NetBackup plug-in for vCenter

■ Manually unregistering the NetBackup plug-in for vCenter

Requirements for the NetBackup plug-in for vCenter
Symantec provides the NetBackup plug-in as a virtual appliance. The requirements
depend on which component of the plug-in you want to use.

The following tables describe the requirements:

Table 2-1 describes the requirements that are common to both monitoring virtual
machine backups and to recovering virtual machines.

Table 2-2 describes the requirements that apply only to monitoring virtual machine
backups.

Table 2-3 describes the requirements that apply only to recovering virtual machines
with the NetBackup Recovery Wizard. This wizard is not required for monitoring
virtual machine backups.
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Table 2-1 Common requirements for the vCenter plug-in virtual appliance

DetailsRequirement

For the vCenter plug-in virtual appliance:

2 vCPU

Minimum 4 GB vRAM

Minimum 24 GB of disk space on the datastore

VM hardware

The vSphere Client host must have access to the vCenter server
where the virtual appliance is installed.

Network access

vCenter Server version 4.0 and later

vSphere Client version 4.0 and later

ESXi version 4.0 U4 and later. (Note that ESXi version 4.1 U3 is
not supported.)

For a list of ESX versions that VMware supports for CentOS 6.4,
refer to VMware documentation. (CentOS 6.4 is the guest OS of
the vCenter plug-in virtual appliance.)

For a list of VMware versions that NetBackup supports, see Support
for NetBackup 7.x in virtual environments:

http://www.symantec.com/docs/TECH127089

VMware versions

Internet Explorer version 7 or later.Web browser in
vSphere Client

For the vCenter systems that run on Windows 2003, it may be
necessary to install a Windows hot fix. Without the hot fix, you may
not be able to access the vCenter plug-in and the message "Action
Canceled" appears. You can download the hot fix from the following
Microsoft support article:

http://support.microsoft.com/kb/968730

Windows 2003 hot fix

Table 2-2 Requirements for monitoring virtual machine backups

DetailsRequirement

NetBackup 7.5 and later.NetBackup versions
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Table 2-3 Requirements for recovering virtual machines with the NetBackup
Recovery Wizard

DetailsRequirement

NetBackup 7.6 and later.NetBackup versions

■ Windows
■ Red Hat
■ SUSE
■ Solaris SPARC
■ Solaris x86

For all the OS levels and versions that are supported for master
server, refer to the NetBackup compatibility lists in the NetBackup
7.6 Release Notes.

NetBackup master
server platforms

The NetBackup Web Services must be enabled on the NetBackup
master server.

See “Configuration overview for the NetBackup plug-in for vCenter”
on page 15.

NetBackup Web
Services

Configuration overview for theNetBackup plug-in for
vCenter

Table 2-4 lists NetBackup configuration requirements that are related to the plug-in.

Table 2-4 NetBackup configuration related to the plug-in

Description and notesTask

For example, the NetBackup administrator must configure the
following:

■ The VMware backup host (access host).
■ The NetBackup credentials for the vCenter server.

Note: The vCenter credentials can be entered as a fully
qualified domain name or IP address. Specify the vCenter
server in the same way when you install the plug-in.

■ Policies of type VMware, with the Post events to vCenter
option set to All Events.

The NetBackup for VMware Administrator's Guide contains
details on setting up VMware policies.

NetBackup must be
configured to back up the
virtual machines.

15Installing the NetBackup Plug-in for vCenter
Configuration overview for the NetBackup plug-in for vCenter



Table 2-5 lists the steps for installing the NetBackup vCenter plug-in. See the
reference topic in the table for details about each step.

Table 2-5 Installing the plug-in

Reference topic and notesDescriptionStep

See “Installing the NetBackup plug-in for
vCenter” on page 18.

Note: From the vSphere Client host, install the
virtual appliance while you are logged into the
vCenter. Network issues may occur if you are
logged directly into the ESXi server.

Install the virtual appliance and
plug-in for vCenter.

1

See “Installing the trusted SSL certificate”
on page 23.

Install the trusted SSL certificate.2

Table 2-6 lists the steps for setting up the NetBackup vCenter plug-in for monitoring
backups.

Table 2-6 Setting up the plug-in for backup monitoring

Reference topic and notesDescription

See “Setting vCenter privileges for backup
monitoring” on page 25.

Set vCenter privileges.

Table 2-7 lists the steps for setting up the NetBackup vCenter plug-in for recovering
virtual machines (the NetBackup Recovery Wizard).

Note: This wizard is not required for monitoring virtual machine backups.

Table 2-7 Setting up the plug-in for the NetBackup Recovery Wizard

Reference topicDescriptionStep

See “Enabling NetBackup Web Services on the
Windows master server” on page 34.

See “Enabling NetBackup Web Services on the
UNIX or Linux master server” on page 36.

Enable the NetBackup Web
Services on the master server.

1

See “Configuring ports for the NetBackup Web
Services” on page 38.

Configure ports for the NetBackup
Web Services.

2

See “Creating an authentication token”
on page 40.

Create an authentication token file.3
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Table 2-7 Setting up the plug-in for the NetBackup Recovery Wizard
(continued)

Reference topicDescriptionStep

See “ Authorizing the plug-in to restore virtual
machines” on page 43.

Authorize the plug-in to restore
virtual machines.

4

See “Setting vCenter privileges for recovering
virtual machines” on page 44.

Set vCenter privileges for virtual
machine recovery.

5

Consistent naming for the vCenter server
The name of the vCenter server must be identical in the following locations:

■ In the NetBackup credentials.

■ In the NetBackup plug-in installation.

■ In the vCenter server installation.

If the fully qualified name of the vCenter server was not used during installation of
the vCenter, do the following in vSphere Client: click View > Administration >
Server Settings, then clickAdvancedSettings. Set the VirtualCenter.VimApiUrl
key to the fully qualified domain name.

If the vCenter server name is not entered correctly, the plug-in may not be able to
access one or more of the virtual machine images.

Upgrading the NetBackup plug-in for vCenter
Follow these steps to upgrade the plug-in from an earlier version.

Table 2-8 Upgrading the plug-in from an earlier version

Reference topic and notesDescriptionStep

Some requirements have changed since
the FA version of the plug-in was issued.

See “Requirements for the NetBackup
plug-in for vCenter” on page 13.

See “Configuration overview for the
NetBackup plug-in for vCenter”
on page 15.

Review the requirements for the plug-in.1
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Table 2-8 Upgrading the plug-in from an earlier version (continued)

Reference topic and notesDescriptionStep

See “Manually unregistering the
NetBackup plug-in for vCenter”
on page 21.

Unregister the existing plug-in.2

See “Disabling or uninstalling the
NetBackup plug-in for vCenter”
on page 20.

Uninstall the existing virtual appliance and
plug-in.

3

See “Installing the NetBackup plug-in for
vCenter” on page 18.

Install the latest version of the virtual
appliance and plug-in.

4

Installing the NetBackup plug-in for vCenter
The NetBackup plug-in for vCenter is provided as a virtual appliance in a
preconfigured virtual machine. The virtual appliance is available in a .zip file on the
FileConnect webpage, as described in this installation procedure.

Note: After the virtual appliance is installed, it should be dedicated to hosting the
NetBackup plug-in: it should not be used for other purposes.

To install the plug-in, you need the following information about the vCenter server:

■ Host name or IP address

■ User name and password

■ Port number for the vCenter server (default is 443).

To install the virtual appliance and plug-in for vCenter

1 In your NetBackup product entitlement letter, locate your serial number for
software downloads.

2 Go to the FileConnect webpage and enter your serial number:

https://symantec.flexnetoperations.com

3 From FileConnect, download the NetBackup plug-in .zip file.

4 Unzip the file and copy the plug-in .ova package to a location that is accessible
to the vSphere Client host.

5 From the vSphere Client host, log in to the vCenter server.
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6 On the vCenter server, select File > Deploy OVF template.

Install the virtual appliance in vCenter, not directly in the ESXi server.

7 Browse to the location of the plug-in .ova package.

Click Next to work through the screens.

8 On the Properties screen, enter static network addresses only. Dynamic Host
Configuration Protocol (DHCP) is not supported.

If your entries do not display properly on the Properties screen, use the
Windows Display Control Panel to reduce the size of the text.

See “The Network Properties screen in the Deploy OVF Template wizard does
not display properly” on page 55.

9 Follow the remaining screens to finish installing the virtual appliance.

10 Click the NBvcplugin virtual machine and click the Console tab.

The boot process continues and asks for a new root password. Set the root
password for the virtual appliance. The boot process continues until the following
appears:

Symantec NetBackup Plugin for vCenter 7.6 Installation Program

11 Follow the installation prompts.

Enter the host name or IP address for the vCenter server, and a user name
and password. For the vCenter server port number and web server port number,
accept the defaults.

Note: You are allowed to re-enter the vCenter logon credentials five times.
Without a valid logon for the vCenter, the installation stops. Delete the
NBvcplugin virtual machine, obtain the correct logon information, and begin
the installation procedure again.

Note: You may need to modify your firewall rules to allow vSphere Client to
access the plug-in host. The vSphere Client host must have access to port
9445 of the plug-in host.

The plug-in installation begins.

12 When installation completes, restart the following:

■ vSphere Client

■ The vCenter service (restart required only for vCenter 4.0)
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The virtual appliance boot process continues.

13 Verify that the plug-in has the correct time.

If the time is not correct, go to the console of the virtual appliance and use the
date command to change the time, as follows.

■ Set the date and time by means of the -s option.
For example:
date -s "Wed Feb 6 09:41:54 UTC 2013"

Note: Symantec recommends keeping the plug-in in UTC.

■ Then restart the virtual appliance.

Disabling or uninstalling the NetBackup plug-in for
vCenter

You can disable the NetBackup plug-in, or remove the virtual appliance that contains
the plug-in.

To disable the NetBackup plug-in

1 In vSphere Client, click Plugins > Manage Plug-ins.

2 Right-click on Symantec NetBackup plug-in for vCenter and click Disable.

The Symantec NetBackup tab is removed.

3 To re-enable the plug-in, right-click on Symantec NetBackup plug-in for
vCenter and click Enable.

To uninstall the NetBackup plug-in

1 Right-click on the virtual appliance that contains the plug-in and selectRemove
from Inventory.

If necessary, the virtual appliance can be re-imported from the datastore. For
permanent removal of the virtual appliance, click Delete from disk.

2 To reinstall the plug-in, you must manually unregister it.

20Installing the NetBackup Plug-in for vCenter
Disabling or uninstalling the NetBackup plug-in for vCenter



Manually unregistering the NetBackup plug-in for
vCenter

Note: The NetBackup plug-in installer allows one plug-in instance per vCenter
server. You must uninstall the current plug-in before you can re-register it with the
same vCenter server.

To manually unregister the plug-in

1 Open a web browser and use the following to log on to the vCenter Server
Managed Object Browser (MOB):

Keep all on one line:

https://vCenter Server IP or host name

/mob/?moid=ExtensionManager&method=unregisterExtension

where vCenter Server IP or host name is the IP address or system name of
the vCenter Server where the NetBackup plug-in is registered.

If the VMware web service does not use the default port 443, specify the
following (all on one line):

https://vCenter Server IP or host name:

PortNumber/mob/?moid=ExtensionManager&method=unregisterExtension

where PortNumber is the VMware web service port number.

2 At the prompt, specify the credentials.

You must have the Unregister extension privilege on the vCenter Server.
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3 In the UnregisterExtension window, enter the following in the extensionKey
value field:

Symantec NetBackup plugin for vCenter

4 Click Invoke Method.

The NetBackup plug-in is unregistered from the vCenter Server.
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Monitoring backup status

This chapter includes the following topics:

■ Configure the NetBackup plug-in for vCenter for backup monitoring

■ Symantec NetBackup tab in vSphere Client

■ Summary display

■ Virtual Machines display

■ Events display

■ Using the Symantec NetBackup tab for backup reporting

■ How to respond to backup status

Configure the NetBackup plug-in for vCenter for
backup monitoring

Before you can use the plug-in to monitor virtual machine backups, configure the
following:

■ Install a trusted SSL certificate.
See “Installing the trusted SSL certificate” on page 23.

■ Set vCenter privileges.
See “Setting vCenter privileges for backup monitoring” on page 25.

Installing the trusted SSL certificate
When you first use the NetBackup plug-in in vSphere Client, you are prompted to
install a trusted SSL certificate. This certificate gets installed on the computer on
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which vSphere Client is running. This certificate authenticates and secures
communication from the vSphere Client to the NetBackup plug-in host.

If you ignore the certificate warning, the same message appears whenever you log
into vCenter. To stop the messages, install the SSL certificate in the Trusted Root
Certification Authorities store, as follows.

To install the trusted SSL certificate

1 When the Security Warning appears, click Install this certificate and do not
display any security warnings for xxxx. Then click View Certificate to
examine the certificate and authenticate the identity of the connecting
NetBackup plug-in host.

2 On the Certificate dialog, click Install Certificate....

3 On the Certificate Import Wizard, click Next.

4 On the Certificate Store dialog, click Place all certificates in the following
store. Click Browse.
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5 Select Trusted Root Certification Authorities and click OK.

6 Click Next.

7 On the final screen, click Finish.

A warning message describes the certificate to be installed.

8 Click Yes.

Setting vCenter privileges for backup monitoring
Use the following procedure to set the user privileges in vCenter that the NetBackup
plug-in requires.

To set required vCenter privileges for backup monitoring

◆ If the user account to access the plug-in cannot be assigned administrator
privileges, you must set the following permissions at the vCenter level.

In vSphere Client, click Home > Roles and set the following:

Global > Manage custom attributes

Global > Set custom attribute

To monitor virtual
machine backups

Symantec NetBackup tab in vSphere Client
The NetBackup plug-in for vCenter displays backup information on the Symantec
NetBackup tab in vSphere Client.
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In the vSphere Client, go to Home > Inventory > Hosts and Clusters and select
a vSphere object.

Note: You must select an object beneath the vCenter server, such as a folder,
datacenter, or ESXi host. The information that appears in the Symantec NetBackup
tab applies to the VMs within the object that you select.

Table 3-1 describes the displays that appear on the Symantec NetBackup tab.

Table 3-1 Summary, Virtual Machines, and Events displays

Information shownDisplay

A summary and graphical view of backup success and backup events,
for a specified time period. Can show the current backup status for a
selected VM.

See “Summary display” on page 26.

Summary

Tabular view of backup information for a group of VMs.

Note: This display is available when you click on a vSphere object that
is above the level of a VM.

You can filter the information with a range of criteria. Includes an option
for customized sorting in multiple columns.

See “Virtual Machines display” on page 28.

Virtual Machines

More detailed tabular view of backup information based on events. Can
show backup events for a VM or its parent object.

You can filter the information with a range of criteria. Includes an option
for customized sorting in multiple columns.

See “Events display” on page 30.

Events

Summary display
The Summary display summarizes backup status, backup events, and backup age
for the VMs in the vSphere object that you select. If you select an individual VM,
the Summary display shows backup status and events for that VM.

Figure 3-1 shows an example of the Summary display for multiple VMs.
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Figure 3-1 Summary display with backup data for multiple VMs

The Summary display presents backup information in the following panels.

Table 3-2 Summary panels

DescriptionPanel

Shows the current backup status and related information for a particular VM or for all the VMs
that belong to the selected vSphere object.

If the panel applies to more than one VM: click on the underlined values (such as for Total or
Backup Successful) to see the details in the Virtual Machines display.

VirtualMachine(s)

Shows the total number of backup events, and a breakdown of the events in three categories:
Backup Successful, Backup Failed, and Snapshot Delete Failed.

Also includes a bar chart that represents the type and number of backup events that occurred
within a specified period. Each bar represents the events that occurred on a particular day. Hover
over a bar to see the number of events for that day: the updated totals appear directly over the
chart.

You can configure the chart as follows:

■ Select the types of events that appear in the chart by clicking on the colored check boxes.
■ Move the slider to adjust the time period, or click on a Zoom time period.

You can also specify the date range by entering start and end dates in the edit boxes. The
maximum date range is one year by default.

Note: Click on the values for Total Events, Backup Successful, Backup Failed, or Snapshot
Deletion Failed to list those events in the Events display.

Backup Events

27Monitoring backup status
Summary display



Table 3-2 Summary panels (continued)

DescriptionPanel

Shows the backup age of the VMs in a bar chart. This panel is available only for a vSphere object
that is higher than the level of a VM.

Virtual Machines
By Backup Age

Virtual Machines display
The Virtual Machines display is available when you click on a vSphere object that
is higher than the level of a VM. For each VM it lists the following: backup
information, the host or cluster, the backup policy, the master server, backup age,
VM age, and the number of consecutive failures.

Use the arrow on the right-most column header to hide or show a column. See
Figure 3-2.

Figure 3-2 Enable or disable columns in Virtual Machines display (detail)

Note: You can move the table columns right or left (drag and drop).

You can also filter the information that appears in this display (View, Filter,Backup
Age).

The display in Figure 3-3 has been filtered to show data only for VMs that meet the
following criteria: the VM has a successful backup, the backup image is up to seven
days old, and the name of the VM contains the letters vm.
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Figure 3-3 Virtual Machines display

Table 3-3 describes the options for filtering or changing the display.

Table 3-3 Display options in the Virtual Machines display

DescriptionOption

Filters the display according to backup status (Backup Successful, Backup Failed, No Backup
Information, Excluded from reporting). For example: If View is set to Backup Successful, it displays
only the VMs that were backed up successfully.

View

Allows additional filtering. Select a type for Filter and enter a filter value in the contains field. For
example: If it is set to Name nfs, it displays only the VMs that have a name that contains the
characters nfs.

Filter

contains

Saves the current Filter type and value (in a blue-highlighted field), to allow the addition of more
filters. Each Filter that you add further narrows the results.

Click on a filter to remove it and refresh the display.

Add

Removes all filtering criteria from the Filter and contains fields and refreshes the display.Clear All

Filters the display according to the age of the backups.Backup Age

Marks a selected VM so that its backup status and other information are not displayed.Exclude

Reverses the Exclude option: Adds a VM's backup status and other information to the display.Include

Saves the information as an Excel file (.xls), as a comma-separated text (CSV) file, or to the Clipboard.Export

Allows customized sorting in multiple columns. Each selection for Column and Order is a level.

For example: If one level isName A to Z, and you add the level Policy Z to A, the information appears
as follows: the VMs appear by name in ascending order, then the VMs appear by policy name in
descending order.

To change the order in which the sorting occurs, select a level and click Move Up or Move Down.

Sort
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Events display
The Events display shows backup information based on events. It can show backup
events for a single VM or for all VMs in the selected object.

Most of the filtering options on this display are described in another topic:

See “Virtual Machines display” on page 28.

Show events since filters the events according to the time period you select.

Figure 3-4 shows an Events display with unfiltered data (the default).

Figure 3-4 Events display

Note the following:

Snapshot Delete Failed: After it creates a snapshot, NetBackup deletes the snapshot
when the backup completes. If NetBackup fails to delete snapshots, the performance
of the VM may eventually decline. In that case, you may need to delete the
snapshots manually.

Using the Symantec NetBackup tab for backup
reporting

The following procedures explain how to find VM backup status in the Symantec
NetBackup tab.

In the vSphere Client interface: Go to Home > Inventory > Hosts and Clusters
and select a vSphere object (such as a datacenter, ESXi host, or VM). The
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information that appears in the Symantec NetBackup tab applies only to the object
that you select.

To find backup status for a single VM

1 Select the VM in vSphere Client.

2 Click the Symantec NetBackup tab.

3 Under Summary, Virtual Machine, see the Current Backup Status and the
Backup Events.

To find backup status for multiple VMs

1 Select the appropriate object in vSphere Client (such as datacenter or ESXi
host).

2 Click the Symantec NetBackup tab.

The Summary display shows the backup success rate for the VMs overall.

See “Summary display” on page 26.

3 For the backup status of particular VMs, click the Virtual Machines display
and find the VMs in the Name column.

Use the View field to select the type of backup message to show (such as
Backup Successful or Backup Failed).

Use Filter to further limit the type of information that appears.

Use Backup Age to filter the display by backup age.

See “Virtual Machines display” on page 28.

To determine which VMs are not backed up

1 Select the appropriate object in vSphere Client (such as datacenter or ESXi
host).

2 Click the Symantec NetBackup tab.

3 Click the Virtual Machines display.

4 Set the View field to Backup Failed.

5 You can use Filter and Backup Age to filter the display.

6 To save the report, click Export and select an output type.
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To determine the age of existing backups

1 Select the appropriate object in vSphere Client (such as datacenter or ESXi
host).

2 Click the Symantec NetBackup tab.

In the Summary display, Virtual Machines By Backup Age shows the age
of the backups (up to one day, up to seven days, and so forth).

3 For information on backup age per VM, click the Virtual Machines display and
look at the Backup Age (days) column.

Set View to All or to Backup Successful.

If necessary, use Filter to filter the displayed information.

4 To save the report, click Export and select an output type.

How to respond to backup status
For the backup status that is reported in the plug-in, the following example actions
may be appropriate. You may need to confer with the NetBackup administrator.

Table 3-4 Tips for responding to backup status in the NetBackup vCenter
plug-in

ActionStatus

■ Look at the number of consecutive failures on the Virtual Machines
display.

■ If too many failures have occurred, export the display results and
send the file to the NetBackup administrator.

Backup failures

■ The VM may not be included in a NetBackup policy, or the Post
events to vCenter policy option may not be correctly configured.
Contact the NetBackup administrator.

■ The VM may be intentionally excluded from scheduled backups
(contact the NetBackup administrator). In that case, you can use
the Exclude option on the plug-in Virtual Machines display to
remove the VM's status from the display.

■ The ESXi server may have been removed from the vCenter server.
See “Notes and recommendations on the NetBackup plug-in”
on page 10.

No backup
information

NetBackup attempts to delete old snapshots at the start of each backup.
If snapshots are not deleted, you can manually delete them in vSphere
Client.

Snapshot delete
failed
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Recovering virtual
machines

This chapter includes the following topics:

■ Configure the NetBackup Recovery Wizard

■ Notes on restoring virtual machines with the NetBackup Recovery Wizard

■ How to access the NetBackup Recovery Wizard

■ NetBackup Recovery Wizard screens

Configure the NetBackup Recovery Wizard

Note: The NetBackup Recovery Wizard is an optional feature of the NetBackup
plug-in for vCenter, for recovering virtual machines. It is not required for monitoring
virtual machine backups.

To use the NetBackup Recovery Wizard to restore virtual machines, configure the
following:
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Table 4-1 Configuring the NetBackup Recovery Wizard

Reference topicDescriptionStep

See “Enabling NetBackup Web Services
on the Windows master server”
on page 34.

See “Enabling NetBackup Web Services
on the UNIX or Linux master server”
on page 36.

Enable the NetBackup Web Services on
the master server.

1

See “Configuring ports for the NetBackup
Web Services” on page 38.

Configure ports for the NetBackup Web
Services.

2

See “Creating an authentication token”
on page 40.

Create an authentication token file.3

See “ Authorizing the plug-in to restore
virtual machines” on page 43.

Authorize the plug-in to restore virtual
machines.

4

See “Setting vCenter privileges for
recovering virtual machines” on page 44.

Set the required vCenter privileges.5

Enabling NetBackup Web Services on the Windows master server
By default, the NetBackup Web Services are disabled on the master server. To
allow the NetBackup plug-in for vCenter to communicate with the master server,
the NetBackup administrator must enable the NetBackup Web Services.

Table 4-2 To enable the NetBackup Web Services on the Windows master
server

Reference topicDescriptionStep

See “To create group nbwebgrp and user
nbwebsvc” on page 35.

Create a group nbwebgrp and a user
nbwebsvc.

1

See “To grant the Log On As Service right”
on page 35.

Grant the Log On As Service right.2

See “To set up NetBackup Web Services”
on page 35.

Set up the NetBackup Web Services on
each master server that the plug-in must
access to perform restores.

3
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To create group nbwebgrp and user nbwebsvc

◆ On themaster server, check whether the nbwebgrp group contains the nbwebsvc
user.

If the user and group do not exist, create them.

nbwebsvc and nbwebgrp can be local user and local group or domain user and
domain group. They can be an Active Directory user and group.

Note: A combination of local user and domain group or domain user and local
group is not supported. Both nbwebsvc and nbwebgrp must be local, or both
must be part of the same domain.

Caution:For security reasons, it is highly recommended to create this user with
a strong password and disable remote login for this user.

To grant the Log On As Service right

1 Go to Control Panel > Administrative Tools > Local Security Policy.

2 Under Security Settings, click Local Policies and then User Rights
Assignment.

3 Right click Log on as a service and select Properties.

Add the nbwebsvc user. For a domain user, include the appropriate domain.

4 Save your changes and close the Log on as a service Properties dialog.

Now you can start the WMC service from the Windows Services tool or by
means of the setupWmc script. In a clustered environment, you must start the
WMC service on all nodes.

To set up NetBackup Web Services

1 Run the setupWmc script on the master server:

■ If the master server is not in a clustered environment:
install_path\NetBackup\wmc\bin\install\setupWmc.bat -password

password

The password is for the local user nbwebsvc.

■ If the master server is in a clustered environment:
install_path\NetBackup\wmc\bin\install\setupWmc.bat -domain

domain_name -password password

The domain_name is for the domain that contains group nbwebgrp and
user nbwebsvc, and the password is for user nbwebsvc.
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Note: If setupWmc.bat fails to start the NetBackup Web Services, a message
is displayed. The following log file contains further details:

install_path\NetBackup\wmc\webserver\logs\nbwmc_setupWmc.log

Enter the following for help with this command:

setupWmc.bat -help

2 To make sure the NetBackup Web Services are enabled, go to the following
location in a web browser:

https://<server>:<port>/nbwebservice/application.wadl

Where:

■ server is the host name or IP address of the master server, or the virtual
name or IP address for clustered environments.

■ port is the port number.
To find the port that NetBackup Web Services uses, enter the following on
the NetBackup master server:
install_path\NetBackup\wmc\bin\install>configurePorts.bat

-status

The HTTP 401 error indicates that the NetBackup Web Services are enabled.

Enabling NetBackup Web Services on the UNIX or Linux master
server

By default, the NetBackup Web Services are disabled on the master server. To
allow the NetBackup plug-in for vCenter to communicate with the master server,
the NetBackup administrator must enable the NetBackup Web Services.

Table 4-3 To enable the NetBackup Web Services on the UNIX or Linux master
server

Reference topicDescriptionStep

See “To create group nbwebgrp and user
nbwebsvc” on page 37.

Create a group nbwebgrp and a user
nbwebsvc.

1

See “To set up NetBackup Web Services”
on page 37.

Set up the NetBackup Web Services on
each master server that the plug-in must
access to perform restores.

2
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To create group nbwebgrp and user nbwebsvc

◆ On themaster server, check whether the nbwebgrp group contains the nbwebsvc
user.

To create the nbwebgrp group, enter the following:

/usr/openv/netbackup/bin # groupadd nbwebgrp

To create the nbwebsvc user, enter the following:

/usr/openv/netbackup/bin # useradd -g nbwebgrp -c 'NetBackup Web

Services application account' -d /usr/openv/wmc nbwebsvc

Enter the command with the values as shown. The -c option specifies the
password file comment, and -d specifies the user's home directory as
/usr/openv/wmc.

Note: Symantec recommends default permissions (UMASK) for the nbwebsvc

user. NetBackup assigns appropriate permissions to this user when it enables
NetBackup Web Services.

To set up NetBackup Web Services

1 Run the setupWmc script on the master server:

/usr/openv/wmc/bin/install/setupWmc

Enter the following for help with this command:

setupWmc -help

2 To make sure the NetBackup Web Services are enabled, go to the following
location in a web browser:

https://<server>:<port>/nbwebservice/application.wadl

Where:

■ server is the host name or IP address of the master server, or the virtual
name or IP address for clustered environments.

■ port is the port number.
To find the port that NetBackup Web Services uses, enter the following on
the NetBackup master server:
/usr/openv/wmc/bin/install/configurePorts –status

The HTTP 401 error indicates that the NetBackup Web Services are enabled.
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Configuring ports for the NetBackup Web Services
The NetBackup Recovery Wizard requires the proper configuration of web ports
for the NetBackup Web Services on the master server. Otherwise, you cannot
authorize the plug-in to restore the virtual machines that were backed up by that
master server.

The NetBackup installation process automatically runs the configurePorts script
to configure NetBackup Web Services to run on any of the following sets of ports.

Table 4-4 Port sets for NetBackup Web Services

shutdown porthttps porthttp portPort set

820584438080First set

830585538181Second set

840586638282Third set

If the configurePorts script does not find one of the sets free (for example, 8080,
8443, and 8205), it logs an error to the following file:

Windows:

install_path\NetBackup\wmc\webserver\logs\nbwmc_configurePorts.log

UNIX and Linux:

/usr/openv/wmc/webserver/logs/nbwmc_configurePorts.log

On UNIX and Linux, the following appears on the NetBackup system console:

configurePorts: WmcPortsUpdater failed with exit status <status_code>

When this error occurs, use the following procedure on themaster server to manually
configure the ports. The configurePorts command is in the following location:

Windows:

install_path\NetBackup\wmc\bin\install\configurePorts

UNIX or Linux:

/usr/openv/wmc/bin/install/configurePorts
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To configure ports for the NetBackup Web Services

1 On the master server, enter the following to list the currently configured ports:

configurePorts -status

Example output:

Current Http Port: 8080

Current Https Port: 8443

Current Shutdown Port: 8205

2 Use the configurePorts command in the following format to re-configure a
port:

configurePorts -httpPort http_port | -httpsPort https_port |

-shutdownPort shutdown_port

You can configure one, two, or three ports at a time. For example, to configure
the http port to 8081 and the https port to 8553:

configurePorts -httpPort 8081 -httpsPort 8553

Output:

Old Http Port: 8080

New Http Port: 8081

Old Https Port: 8443

New Https Port: 8553

Use this command as needed to configure a set of ports for http, https, and
shutdown. See Table 4-4 for a list of the port sets.

3 If the master server is in a clustered environment, do the following:

■ Make sure that the same set of ports are free on all the cluster nodes: Do
step 1 on each node.

■ Reconfigure the ports on each node as required: Do step 2.

■ To override the ports that are used across all nodes, enter the following:
configurePorts –overrideCluster true

This command updates the following file on shared disk:
Windows:
install_path/NetBackup/var/global/wsl/portfile

UNIX or Linux:
/usr/openv/netbackup/var/global/wsl/portfile

The NetBackup installer for Web Services uses this file during installation
in a clustered mode.

39Recovering virtual machines
Configure the NetBackup Recovery Wizard



Creating an authentication token
To allow the plug-in to restore VMs, you must generate an authentication token on
the NetBackup master server (or on the appliance as master server).

To create an authentication token on the NetBackup master server

1 Enter the following on the master server:

Windows

install_path\NetBackup\wmc\bin\install\manageClientCerts.bat

-create vCenter_plugin_host

UNIX, Linux

/usr/openv/wmc/bin/install ./manageClientCerts -create

vCenter_plugin_host

where vCenter_plugin_host is the fully qualified domain name of the vCenter
where the plug-in is installed.

The manageClientCerts command returns the location of a compressed file
that contains the authentication token.

2 Provide the compressed file to the vCenter administrator.

Caution: Be sure to share or send the compressed file in a secure manner.

With the master server token, the plug-in can be authorized to restore virtual
machines.

See “ Authorizing the plug-in to restore virtual machines” on page 43.
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To create an authentication token on the NetBackup appliance as master server

1 Use the CLISH on the appliance to enter the vCenter Client Administration
view:

nbapp213.Manage> vCenter

The following appears:

Entering vCenter Client Administration view...

Credential Manage vCenter client credential

Exit Logout and exit from the current shell.

Return Return to the previous menu.

Shell Shell operations.

2 Enter the following:

nbapp213.vCenter> Credential Create vCenter_plugin_host

where vCenter_plugin_host is the fully qualified domain name of the vCenter
where the plug-in is installed. The following is example output:

Successfully created client certificate for 'vCent_1' to secure

access to the NetBackup Web Service Layer on Master Server

'nb-appliance', port '8443'.

In this example, the compressed file is created at:
/usr/openv/var/global/wsl/credentials/clients/vCent_1.zip

3 Provide the compressed file to the vCenter administrator.

Caution: Be sure to share or send the compressed file in a secure manner.

With the master server token, the plug-in can be authorized to restore virtual
machines.

See “ Authorizing the plug-in to restore virtual machines” on page 43.

Revoking an authorization token
You can delete or revoke a master server authentication token, as follows.
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To revoke the authorization token

1 Enter the following on the master server:

Windows

install_path\NetBackup\wmc\bin\install\manageClientCerts.bat

-delete vCenter_plugin_host

UNIX, Linux

/usr/openv/wmc/bin/install ./manageClientCerts -delete

vCenter_plugin_host

where vCenter_plugin_host is the fully qualified domain name of the vCenter
in which the plug-in is installed.

The -delete option removes the authentication token and its compressed file
from the master server. The plug-in is no longer authorized to restore virtual
machines from backups that were made by this master server.

2 To re-authorize the plug-in for restores for this master server, create a new
token and if necessary re-add the master server in vSphere Client.

See “Creating an authentication token” on page 40.

See “ Authorizing the plug-in to restore virtual machines” on page 43.

Listing all current authorization tokens
You can list all the master server authentication tokens that are presently in use.

To list all current authorization tokens

◆ Enter the following on the master server:

Windows

install_path\NetBackup\wmc\bin\install\manageClientCerts.bat -list

UNIX, Linux

/usr/openv/wmc/bin/install ./manageClientCerts -list

Sample output:

Client Expiry Date

vCenter-server-1 Thu Feb 06 16:16:51 GMT+05:30 2014

vCenter-server-2 Fri Feb 07 11:22:53 GMT+05:30 2014
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The command lists the vCenter servers for which the tokens were created as
well as their expiration dates. It can help diagnose communication problems
between the plug-in host and the master server when a certificate has expired.

■ For well-formatted output, set the command prompt or shell screen size to
more than 100 units.

■ Server names that are longer than 40 characters are truncated: Characters
beyond the first 40 are replaced with “...”.

Authorizing the plug-in to restore virtual machines
The NetBackup master server initiates and controls the backup of virtual machines.
To use the plug-in to restore virtual machines, you must obtain a master server
authentication token from the NetBackup administrator. Then you can authorize
the plug-in to restore the virtual machines that were backed up by that master
server.

To authorize the plug-in to restore virtual machines

1 Ask the NetBackup administrator to provide an authentication token file.

See “Creating an authentication token” on page 40.

2 Copy the authentication token file to the vSphere Client host (make a note of
the location).

3 In vSphere Client, click Home.

4 Click the Symantec NetBackup icon.

5 Click Add/Remove Servers.

6 Enter the following to specify a NetBackup master server and its authentication
token.

■ NetBackup Master Server
Enter the fully qualified domain name of the master server.

■ Port for NetBackup Web Services
If the NetBackup administrator has not changed the port, accept
the default (8443). Otherwise, contact the administrator for the
correct port number.

■ Upload Authentication Token
Click Browse to select the authentication token file that the
NetBackup administrator provided.

■ Click Add Server. The server is added to the list of master
servers that the plug-in can communicate with.

Add NetBackup
Master Server
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Note: If an "Out of sync" message appears after you add a master server, click
on the message as requested. This message can be ignored: it does not
indicate a problem in adding the NetBackup authentication token.

Note: If a "Connection Refused" message appears, the ports for the NetBackup
Web Services may not be correctly configured on the master server. The
following topic contains configuration instructions.

See “Configuring ports for the NetBackup Web Services” on page 38.

7 Add other master servers and their authentication tokens as needed.

8 You can also remove a master server from the list of servers, or validate the
connection from the plug-in to a master server.

After the master server is added to the list, you can validate the
connection. Type or select the master server and click Validate.

Click Remove to remove the server from the list. The plug-in is
no longer able to monitor or restore backups that the master server
performed.

Validate/Remove
NetBackup
Master Server

Setting vCenter privileges for recovering virtual machines
Use the following procedure to set the user privileges in vCenter for the NetBackup
Recovery Wizard.

To set required vCenter privileges for recovering virtual machines

◆ If the user account to access the plug-in cannot be assigned administrator
privileges, you must set the following permissions at the vCenter level.

In vSphere Client, click Home > Roles and set the following:

NetBackup Recovery > Add or Remove NetBackup Servers

NetBackup Recovery > Virtual Machine Recovery

Global > Log Event

Note:When you deploy the plug-in, NetBackup recovery privileges are
automatically enabled for the Administrator role. These privileges allow
the VMware administrator to use the NetBackup Recovery Wizard to
recover virtual machines to any destination in vCenter. To give the
recovery privileges to other users, you must enable the NetBackup
Recovery privileges for other roles.

To recover virtual
machines
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Caution:The NetBackup Virtual Machine Recovery privilege grants global recovery
authorization. It allows users with that role to recover any virtual machine that resides
on that vCenter. Use caution when granting this privilege to users.

Notes on restoring virtual machines with the
NetBackup Recovery Wizard

Use the Symantec NetBackup Recovery Wizard in vSphere Client to restore a
virtual machine from its NetBackup image. You can restore the virtual machine to
its original location or to a different location.

Note the following about the NetBackup Recovery Wizard:

■ For the pre-requisites for using the Recovery Wizard:
See “Configure the NetBackup Recovery Wizard” on page 33.

■ The NetBackup Recovery Wizard is an optional feature of the plug-in. It is not
required for monitoring virtual machine backups.

■ The NetBackup Recovery Wizard is for recovery of an entire virtual machine,
not for recovery of individual files. To recover individual files from the virtual
machine backup, use the NetBackup Backup, Archive, and Restore interface.
See "About restore of individual files" and "Restoring individual files" in the
NetBackup for VMware Administrator's Guide.

■ The Recovery Wizard does not support recovery of vCloud Director backup
images. To recover virtual machines into vCloud Director, use the NetBackup
Backup, Archive, and Restore interface.
See the "Use NetBackup for vCloud Director" chapter in the NetBackup for
VMware Administrator's Guide.

■ The Recovery Wizard does not use NetBackup's Instant Recovery feature.

How to access the NetBackup Recovery Wizard
In vSphere Client, you can launch the Recovery Wizard in any of three ways as
shown in Table 4-5
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Table 4-5 Three ways to start the NetBackup Recovery Wizard in vSphere
Client

DescriptionAction

Right click on the virtual machine and select
Symantec NetBackup Recovery Wizard.

By default, the wizard selects the original location as
the target for the restore. You can overwrite the virtual
machine in the original location or direct the restore
to another location.

Click Home, click the Symantec NetBackup
Recovery icon, and then click Start VM Recovery
Wizard.
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Table 4-5 Three ways to start the NetBackup Recovery Wizard in vSphere
Client (continued)

DescriptionAction

In the Symantec NetBackup tab, click the Events
tab, click on a successful backup event for the virtual
machine, and click the Recover tab.

NetBackup Recovery Wizard screens
Use the following screens to restore a virtual machine with the VMware vSphere
Client interface.

Select source virtual machine
Select the virtual machine to restore.

Table 4-6 Select source virtual machine (NetBackup plug-in Recovery Wizard)

DescriptionField

Use the drop-down list to select the master server that made the backup.

If the master server is not in the drop-down, you must add the server to the master server
list.

See “To authorize the plug-in to restore virtual machines” on page 43.

Select NetBackup
Master Server

Enter the virtual machine name (or portion of the name) that you want to restore, and click
Search.

Note: This field is case-sensitive.

When you access this dialog by means of Home > Symantec NetBackup > Recovery
Wizard, this field does not accept pasting values from the Clipboard. You must enter a value
manually. For security reasons, VMware does not allow pasting values into this field.

Enter Display Name
or UUID or DNSName
or Host Name
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Table 4-6 Select source virtual machine (NetBackup plug-in Recovery Wizard)
(continued)

DescriptionField

The results of the search appear in this list.

Click the virtual machine to restore and then click Next.

Select Client

Select Backup
In the NetBackup plug-in Recovery Wizard, select the backup image from which to
restore the virtual machine.

Table 4-7 Select Backup (NetBackup plug-in Recovery Wizard)

DescriptionField

Use the drop-down to select the backup, as follows

■ Latest Backup
Selects the latest available backup image.

■ Manually Specify
Click this option to select a different backup image. The Browse backups button appears.
Click that button and enter a date range within which to search for images. The vmdk files
for the image you select appear under the Virtual Machine Attributes area.
A red triangle next to the date field indicates the entry of an unsupported date format. Use
the calendar icon to select a date.
The Select Backup screen in some cases allows the incorrect entry of a date.
Click Select this backup to select the backup image.

Select Backup

Displays the information on the backup image and the attributes of the virtual machine at the
time it was backed up.

Backup Details

Destination Options
Specify the destination for the restored virtual machine.

Table 4-8 Destination Options (NetBackup plug-in Recovery Wizard)

DescriptionField

Lists the details of the original location.Original Location

Selects the original location (ESXi server, folder, resource pool, datastore, or cluster) as the
restore location. (This setting is the default.)

To accept the original location, click Next.

Use Original
Location
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Table 4-8 Destination Options (NetBackup plug-in Recovery Wizard)
(continued)

DescriptionField

The ESXi server for the restored virtual machine.

Click Change to browse for an ESXi server.

ESXi

The folder for the restored virtual machine.

Click Change to browse for a folder.

VM Folder

The resource pool for the restored virtual machine.

Click Change to browse for a resource pool.

Resource Pool

The datastore or datastore cluster for the restored virtual machine.

Click Change to browse for a datastore or datastore cluster.

Datastore or
Cluster

The display name for the restored virtual machine. You can enter the name.Display Name

Transport Modes
Select the recovery host and data transfer mode for the virtual machine restore.

Table 4-9 Recovery host and transport modes (NetBackup plug-in Recovery
Wizard)

DescriptionField

The host that performs the recovery. The default is the host that performed the backup (the
backup host).

In most cases, use the host that performed the backup. Selecting a different host as the recovery
host can result in a slow restore or a failed restore, depending on the transport mode.

For example, the restore may fail if you select the SAN transport mode in the following case:

■ The host that performed the backup used a SAN connection to access the datastore.
■ The host you select as recovery host does not have SAN access to the datastore.

NetBackup
Recovery Host

Determines how the restore data is sent from the recovery host to the VMware datastore. The
appropriate option depends in part on the type of network that connects the VMware datastore
to the recovery host.

Click a mode on the left and use the arrow to add it to the Selected modes in preference order
panel on the right. The first mode that is added is the first transfer mode that NetBackup tries for
the restore.

Transport Modes

For unencrypted transfer over Fibre Channel (SAN) or iSCSI.san
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Table 4-9 Recovery host and transport modes (NetBackup plug-in Recovery
Wizard) (continued)

DescriptionField

For unencrypted transfer over a local network that uses the Network Block Device (NBD) driver
protocol. This mode of transfer is usually slower than Fibre Channel.

nbd

For encrypted transfer (SSL) over a local network that uses the Network Block Device (NBD)
driver protocol. This mode of transfer is usually slower than Fibre Channel.

nbdssl

Requires that the recovery host is in a virtual machine.

For instructions on this transport mode and on installing the recovery host in a virtual machine,
refer to your VMware documentation.

hotadd

Disk Options
Select the provisioning for the restored disks.

Table 4-10 Disk options (NetBackup plug-in Recovery Wizard)

DescriptionField

Restores the virtual machine's virtual disks with their original provisioning.Same as original

Configures the restored virtual disks in the thick format. The virtual disk space is allocated when
the disk is created. This option restores the populated blocks, but initializes vacant blocks with
zeros later, on demand.

Thick Provision
Lazy Zeroed

Configures the restored virtual disks in the thick format. Restores the populated blocks and
immediately initializes vacant blocks with zeros (eagerly zeroed). Creation of the virtual disks
may take more time with this option. However, if the restore occurs over a SAN, the eagerly
zeroed feature may speed up the restore by reducing network communication with the vCenter
server.

Thick Provision
Eagerly Zeroed

Configures the restored virtual disks in the thin format. Restores the populated blocks but does
not initialize vacant blocks or commit them.

Thin Provisioning

Virtual Machine Options
Select the recovery options for the virtual machine.
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Table 4-11 Virtual machine options (NetBackup plug-in Recovery Wizard)

DescriptionField

Retains the UUID of the original virtual machine (note that the UUID is a globally unique
identifier). The virtual machine is restored with the same UUID that it had before the restore.

Note the following:

■ If a virtual machine with the same display name but with a different UUID exists at the
target restore location, the restore fails. You must either delete the existing virtual machine
and run the restore, or keep the existing virtual machine and abandon the restore.

■ If you do not want to keep the existing virtual machine, you can do one of the following:
Remove the existing virtual machine, or log into the ESXi server and remove the directory
where the virtual machine resides.

Restore BIOS UUID
instead of creating a
new

The recovered virtual machine is automatically turned on when the recovery is complete.Power on virtual
machine after
recovery

If a virtual machine with the same display name exists at the destination, that virtual machine
must be deleted before the restore begins. Otherwise, the restore fails. Select this option to
have the virtual machine deleted.

Overwrite existing
virtual machine

This option restores the virtual machine with its original hardware version (such as 4). It
retains the original version even if the target ESXi server by default uses a later hardware
version (such as 7 or 8).

If this option is disabled, the restored virtual machine is converted to the default hardware
version that the ESXi server uses.

Retain hardware
version

Network Connectivity Options
Select the networks for the recovered virtual machine.

Table 4-12 Network connectivity options (NetBackup plug-in Recovery Wizard)

DescriptionField

Selects or unselects all the networks that are available. If a network is selected, the restored virtual
machine is automatically connected to that network.

You can select individual networks for the restored virtual machine.

Select All

Recovery Summary
Preview the recovery details.
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Table 4-13 Recovery summary (NetBackup plug-in Recovery Wizard)

DescriptionField

Lists the settings that are used for the recovery.Destination

Click Run Pre-Recovery Check.

Verifies the credentials and appropriate paths and connectivity, determines whether the datastore
or datastore cluster has available space, and reviews other requirements. You must run this
check at least once. You can proceed with the restore even if the check fails.

Pre-Recovery
Check Results

Starts the recovery of the virtual machine.

This button is not available until you run a pre-recovery check.

Recover
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Troubleshooting

This chapter includes the following topics:

■ The NetBackup vCenter plug-in does not appear in vSphere Client

■ Reducing the load time for the NetBackup vCenter plug-in

■ The Network Properties screen in the Deploy OVF Template wizard does not
display properly

■ The Symantec NetBackup tab is blank

■ The Recovery Wizard does not find any backup images

■ The Recovery Wizard does not find a particular backup image

The NetBackup vCenter plug-in does not appear in
vSphere Client

The plug-in may not appear if vSphere Client fails to access the plug-in host.

In vSphere Client, clickPlug-ins >Manage Plug-ins. A NetBackup plug-in message
similar to the following indicates that vSphere Client cannot connect to the plug-in.
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Recommended actions:

■ Verify that the vSphere Client host can access the plug-in by name. You may
have to modify C:\Windows\System32\drivers\etc\hosts on the vSphere
Client host to correct the name resolution.

■ Verify that the plug-in host (virtual appliance) is running.

■ Verify that the host name being accessed is correct. If the plug-in host is
configured with the wrong host name, delete the virtual appliance and reinstall
it.

Reducing the load time for the NetBackup vCenter
plug-in

If the plug-in takes a long time to load, too many backups may have occurred in
your environment.

To reduce the load time for the NetBackup vCenter plug-in

1 Log in to the plug-in virtual appliance using vSphere Client.

Log in as the root user and specify the password that was supplied during the
plug-in installation.

2 Open the following file in a text editor:

/etc/nbvcplugin.env

3 Find the following line in the file:

export MAX_EVENT_HISTORY_IN_DAYS=365

By default, the vCenter plug-in retrieves backup events for the last 365 days.
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4 Change the numeric value of MAX_EVENT_HISTORY_IN_DAYS to a lower
positive number (non-zero). For example: 30.

This change limits the number of backup events that the plug-in retrieves. As
a result, it reduces the plug-in's initial load time.

5 Save the file and exit the text editor.

6 For this setting to take effect, enter the following commands to restart the
plug-in service:

service nbvcplugin stop

service nbvcplugin start

7 Log out of the plug-in virtual appliance.

The Network Properties screen in the Deploy OVF
Template wizard does not display properly

During installation of the virtual appliance, the deployment wizard Network
Properties screen may display improperly if the Windows text size is set too large.
For example:
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To correct the display, go to the Windows Control Panel and click Display. Set the
text size to 100%.

The Symantec NetBackup tab is blank
In vSphere Client, if an operation in the Symantec NetBackup tab results in a
blank display, close and restart the vSphere Client. Then retry the operation.

TheRecoveryWizarddoesnot find anybackup images
The NetBackup plug-in Recovery Wizard may encounter this problem for any of
the following reasons:

■ The vCenter name resolution for the master server IP on the plug-in host is
different from the name resolution for the master server IP on the master server.

■ The vCenter was added to the master server using its name but the plug-in was
configured using its IP.

■ The time setting on the plug-in host is incorrect.

Recommended actions:

■ Verify that the name of the plug-in on the plug-in host is identical to the name
entered under Credentials on the NetBackup master server. The following two
name entries should match:

■ On the plug-in host enter the following:
/opt/SYMCnbvcPlugin/tomcat/webapps # cat /etc/nbvcplugin.env |

grep SERVER_NAME

Example result: SERVER_NAME=vmserver.acme.com

■ Find the virtual machine server name in the Administration Console on the
NetBackup master server, under Media and Device Management >
Credentials > Virtual Machine Servers:
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The name that appears in the Administration Console should match the name
that was returned on the plug-in host.

■ Verify that the time setting on the plug-in host (virtual appliance) is correct. If
necessary, set the current time using the date command.
For example:
date -s "Wed Feb 6 09:41:54 UTC 2013"

Note: Substitute the current date and time for the values in this example.
Then restart the virtual appliance.

TheRecoveryWizarddoesnot findaparticular backup
image

The NetBackup plug-in Recovery Wizard may not find the backup image for a
particular VM if the VM display name contains special characters.

To locate the backup image, start the recovery as follows:

■ In vCenter, click Home, click the Symantec NetBackup Recovery icon, and
then click Start VM Recovery Wizard.

■ In the wizard, enter the VM name (full or partial) to begin recovery.
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